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Clients & Profits Xvides many ways to track a job’s progress on-line. The job’s 
“snapshot” provides an up-to-the-minute look at its estimate vs. billings, 
estimated hours vs. actual hours, profit to date, and the job’s next billing. The 
job’s “progress” window shows totals for each job task.

To view a job’s snapshot

The Job Snapshot window sup-
plies account executives, account 
coordinators, and others with an 
up-to-the-minute snapshot of a job’s 
progress.  Quick calculations show 
the job’s remaining estimate and 
profit-ability. This helps users catch 
any problems before they become 
serious—and expensive or trouble-
some to fix. A job’s advance billing 
balance appears in the Snapshot 
window. The balance is the amount 
you can apply against upcoming 
invoices for this job.

Account executives can use the job 
snapshot to better plan the upcom-
ing billings. By entering the date 
and amount of the job’s next billing, 
pre-billing reports can be printed.  
These reports show what’s 
expected to be billed during the 
next billing 
cycle. The job’s account executive will be 
notifiedby e-mail on the billing date.  Account 
executives can use the job snapshot to 
review a job’s estimates vs. actuals. If a 
job looks like it is costing too much, the 
over budget amount can be entered into 
the snapshot window. Progress reports  can  
be printed showing these problem jobs, so that  
they can be watched more closely.

1  From the job ticket window, click on the Snapshot button.

The Job Snapshot window opens displaying the jobs estimate, hours, profit-
ability, and billing totals. If account planning is important, the cost amounts 
and hours needed to finish the job, as well as the amount and date of the 
next billing, can be entered here. These amounts appear on the Snapshot 
Worksheet report, which can be used by account supervisors to track each 
job’s percentage complete.

2  Enter the job’s needed and next billing information, then click Save.

Tracking Job Progress

Tracking Job Progress

The job snapshot window’s updated field is changed automatically when you 
click Save. To print a hard-copy printout of the job’s snapshot window, click 
the Print button.

To view a task’s costs, and billings

A job’s costs, and billing amounts 
can be conveniently viewed from 
the Job Tickets window. The job’s 
activity is displayed in detail on 
screen. The View>Point options are 
an extremely fast and simple way to 
see a job’s activity without printing 
lots of reports. The job’s activity can 
be viewed anytime by selecting the 
job’s drop-down menu.

■  To see the job’s costs, select Task 
Costs 

■  To see the job’s billing amounts, 
select Task Billings.

The same costs and billing amounts 
can be printed for many jobs, as well 
as one project, from the Print Job 
Reports window.

To review a job’s progress

The Job Progress window shows a job task’s totals to date. For each job task 
you’ll see its budgeted hours and budgeted costs compared with the its 
actual hours and actual costs. The percentage of budget used is calculated for 
each job task, easily showing how much of its budget remains.  Calculations 
are the bottom of the window compare the percentage completed for the 
entire job based on its total budget and total costs.

The window’s toolbar buttons let you verify the job’s costs and billings (its 
identify the Verify/Recover utility), printing the job’s Job Progress report, 
and for printing a job’s costs, billings, and purchase orders. For jobs with 
large numbers of tasks, the Show Groups pop-up menu lets you compare the 
progress of different groups of tasks at one time.

1  From the Job Ticket window, choose Job Progress from the View>Point 
drop-down menu.

The Job Diary

Each job ticket has a diary that tracks the job’s history. The job diary helps 
users see what kind of changes have been made since the job was opened. 
A production manager can see a job’s history from his or her own computer, 

Plan the month’s billings.
The job snapshot window’s 
Billing Worksheet section 
shows the job’s unbilled 
total. The job’s next billing 
amount and the date 
will be summarized on 
the Snapshot Worksheet 
report.
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instead of tracking down and interrogating everyone who worked on it.

Job diary entries are made automatically when many kinds of changes are 
made. 
Entries are made when the job is opened, then anytime the specifications, 
estimates, 
or schedules are edited. They are also made whenever new tasks are 
added, removed, or changed as 
well as 
when the status is updated. 
Closing the 
job makes a diary entry, as does 
deleting 
a job. A deleted job’s diary 
stays in the 
database—so it’s easy to know 
who deleted 
a job ticket. The deleted job’s 
diary can be 
printed from job reports.

Each diary entry shows the date 
and time a 
change was made and who 
made it. A short, 
default description describes 
each entry. In 
addition, a user can include a 
longer explanation if needed. 
The information on an existing 
diary entry, except for the notes, can’t be 
changed. New entries can be added manually 
to document client meetings, memos, and 
phone calls important to a job’s progress. 
Diary entries don’t appear on client reports, 
but can be printed with job reports.

■  Since one of the important functions of 
the job diary is to track who did what on 
a job, diary entries can’t be deleted. If an 
entry were deleted, the job history would be 
incomplete.

To see a job’s diary

1  From the Job Ticket window, click the Job Diary button or choose Edit > 
Job Diary.

The job’s diary entries appear in the window, sorted by date (newest entries 
first). Entries can be resorted by clicking on the different column headings 
(i.e., when, who, what). The sort order can be reversed by clicking on the Sort 

buttons in the toolbar. Double-click on a diary entry to see its notes.

To add a diary entry

Most diary entries are entered automatically while you’re working. The only 
entries you might need to make are for events that occur outside of Clients & 
Profits X, like client meetings, approvals, phone calls, etc. 

1  From the Job Diary window, 
click the (i.e., Add) button 
then enter the date, time, 
short description, and notes 
that explain this entry.

The diary’s user initials can’t 
be changed. An e-mail mes-
sage can be sent by entering 
a staff member’s initials. 
The e-mail message is sent 
immediately when the entry 
is saved. The diary’s notes be-
come the body of the e-mail. 
For security reasons, job diary 
entries can only be sent to 
staff members.

2  Click Save.

“Who added that task?”
Job diary entries are made 
automatically whenever 
tasks are added or removed, 
traffic is edited, and more. 
Double-clicking on a diary 
entry shows its full details. 
Selected entries can be 
printed by pressing down the 
Command (or Ctr in Windows) 
key then highlighting the 
entries to print then clicking 
the Print button.
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Client Billing/Accounts 
Receivable

Everything you do for a client is billed by adding an invoice into Accounts 
Receivable.  Clients can be billed for anything you do—whether you’re billing 
an estimate, an advance, a retainer, a service charge, or a job’s final costs.  
Accounts receivable invoices are seamlessly integrated with jobs and costs, 
so billing is particularly quick and easy—and can be mostly automatic.

Every kind of client invoice—including deposits, retainers, advances, credits, 
and discounts—should be added into Accounts Receivable.  Invoices have one 
or more line items, which contain the actual billing amounts.  Every task on a 
job can be billed as a separate line item on an invoice, providing your clients 
with a clear, detailed billing—one that looks like their estimate.

Invoices can be created for job tickets, anytime, one at a time or all jobs at 
once.   All you need to know is the job number; Clients & Profits X copies the 
job’s tasks, descriptions, and unbilled amounts to the invoice automatically.  
The printed invoice shows the job’s details, such as specifications, contacts, 
and billing information.

A job can be billed at anytime, as many times as needed.  An invoice can bill 
one job ticket, or contain billings for many different jobs and tasks—even jobs 
for different clients.   

Billing, obviously, is one of the job’s most important steps.  It summarizes 
all of the work you’ve done on a job—including payables, time, checks, and 
expenses—on a simple, concise printed invoice.  Invoices can be added at the 
end of the month, or throughout the month as jobs are completed.  Billing 
works like this:  (1) Unbilled jobs are reviewed on work in progress reports to 
see what’s ready to bill; (2) account executives can adjust unbilled amounts, 
if needed, to fine-tune what will be billed.  Costs, time, and expenses can be 
transferred between jobs to the same task; (3) from these work in progress 
reports, invoices are added for each job’s unbilled tasks.  The auto-bill option 
can bill these jobs automatically in one step; (4) these new invoices are 
proofed, edited, then posted.  Posting updates the client’s balance, job totals, 
and the financial statements; (5) the new invoices are printed, then mailed to 
clients; (6) when the client sends a payment, it is added into Client Payments 
and applied to these unpaid invoices. This completes the billing cycle.

Everything you bill affects the client account and the General Ledger when 
invoices are posted. Invoices are posted to update clients, jobs, and the Gen-
eral Ledger.  Posting an accounts receivable invoice creates General Ledger 
journal entries automatically.  The invoice’s total makes a debit entry, usually 
updating the A/R account; each invoice line item makes a credit entry, 
usually for an income account. Posted invoices appear on job reports, billing 
reports, statements, and client aging reports.  

Client Billing/Accounts Receivable

Job Billing  Job billings lets you 
create an invoice by selecting any 
job’s tasks.

Advance Billing  Advances bill 
jobs from their estimates, before 
work has begun. Tasks aren’t billed; 
instead, the client only sees an 
advance billing amount.  You can 
bill all or part of the estimate.  
The job’s total billings aren’t af-
fected; instead, it updates the job’s 
advance billing total.  Advance 
billings can be applied like a pay-
ment to later invoices.  Additonally, 
they don’t affect income, instead 
they credit a liability account 
(e.g.,unearned income).

Progress/Final Billing  Invoices a 
job’s unbilled tasks in one step.

Estimate Billing  Estimate billings 
invoice a job’s estimates, show-
ing tasks. Unlike advances, they 
increase the job’s billed totals.

Media Billing  This option lists un-
billed insertion orders or broadcast 
orders.  Each insertion appears as a 
separate billing amount, showing 
its publication, issue date, ad#/
caption, and gross cost.

Multi-job Billing  This option lets 
you bill one client for one or more 
jobs and their tasks.

Miscellaneous  Bills clients for non-
job charges like consulting fees.

Retainer  Retainers bill clients for 
account service fees, based on a 
retainer billing schedule. They don’t 
affect jobs. Retainers are applied as 
payments to future job invoices.

Billing types

An invoice’s billing amounts come 
from job tasks.  Each job task keeps 
a running total of its costs, time, 
checks, and expenses from the 
day the job began.  The job task’s 
unbilled balance shows its unbilled 
gross costs (which includes mark-
ups, commissions, and billing rates) 
less what’s been billed before.  

Job costs aren’t literally billed on 
the invoice.  Instead, the invoice 
bills the job’s tasks—specifically, 
each task’s unbilled amount.  When 
you bill a job, every task that 
has unbilled costs can appear 
on the invoice (either automati-
cally or manually, your choice).  
The invoice’s billing amount is 
copied from the job task’s unbilled 
amount.  So clients don’t see every 
cost, time entry, and expense on 
invoices; instead, they only see job 
tasks.

You can freely change the invoice’s 
billing amounts.  The job’s costs 
are unaffected, giving you the f lex-
ibility to bill any amount you wish 
without making complex, time-
consuming adjusting entries.

Where do billing amounts 
come from?
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The Accounts Receivable window

The Accounts Receivable window

1  Use the arrow toolbar buttons to 
scroll through the previous and next 
accounts receivable invoices.

2  To automatically bill clients 
or projects for selected unbilled 
job tickets, click on the auto-bill 
button.  

3  To add a new job billing invoice, 
click on the add button.  Clicking 
on the edit button lets you edit 
the billing’s invoice description. 
To change billing amounts, click 
on the edit amounts button. To 
delete a billing, click on the delete 
button.  

4  Amounts can be easily added 
and removed from an unposted 
billing using the add amount and 
remove amount buttons.  

5  Use the print reports and print 
invoices buttons to print Accounts 

Receivable reports and invoices.

6  Enter the invoice number here to 
find a billing. 

7  Use the history pop-up menu to 
jump to a previously viewed billing.

8  Click on these links to quickly 
see the most important parts of an 
invoice, then make changes. 

9  Invoices are automatically num-
bered or you can enter your own 
invoice number. The next invoice 
number can be set in Preferences. 
It can contain up to 10 numbers.  

10  The billing type indicates what 
kind of charges were billed on this 
invoice (e.g., estimate, progress/
final, media, advance, retainer, 
miscellaneous, etc.). 

11  The added by initials show 

which user added the invoice.  

12  Every invoice includes one 
client number, one or more job 
numbers, a description, and an 
invoice date. This information ap-
pears on the printed invoice. 

13  The client’s PO number is 
copied from the job ticket. The 
payment terms are copied from the 
client account. Both appear on the 
printed invoice. 

14  The due date is the date on 
which the invoice’s payment is 
expected, and is used by the Cash 
Flash report. Clients never see the 
due date.

15  The Balance due shows the 
invoice’s total charges (including 
sales tax) less any retainer, ad-
vance, or client payments. Posting 
updates the client account, jobs 

and tasks, and the General Ledger. 
Posting an invoice updates the G/L 
based on its accounting period. 

16  The days due box shows a 
countdown of how many days are 
left until the invoice reaches it’s 
due date.  

17  Each invoice line item can 
include a job, task, description, 
and billing amount. Double-click on 
a line item to see and edit a billing 
amount.

18  If a retainer or advance pay-
ment was applied to an invoice, its 
description and amount appear at 
the bottom of the window—and the 
printed invoice.

19  The total amount of the billing 
includes sales tax plus the total of 
all invoice line item amounts.  
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Client invoices can be printed any time after they are posted. Invoices can 
be printed individually, or in batches for a range of invoice numbers. A batch 
of invoices can also be printed for the same client and a range of invoice 
dates; this option lets you print the month’s invoices for one client quickly 
and easily.

The printed invoice shows the line items, billing amounts, descriptions, and 
notes you’ve entered into the invoices. Each invoice can have its own set of 
options and settings (e.g., 
display options, group and 
sort, show or hide totals, 
etc.) that affect the look 
of the billing. So printing a 
large number of invoices at 
the same time may show 
a wide variety of invoice 
styles.  

Invoices are designed to 
print on your letterhead.  
The invoice margins are cus-
tomizable, and can be set 
by choosing Invoice Options 
from the Preferences pop-up 
menu. None of the invoice’s 
options can be changed 
at the time invoices are 
printed. To change these 
options you must make your 
changes first, then print the invoice. The optional agency billing address is 
printed from Agency Information, where it can be changed.

An invoice can be printed then reprinted any number of times.  As an option, 
a job cost report can be printed showing costs billed on these invoices. This 
invoice detail report can be used to back up the billing amounts on invoices, 
if you bill strictly based on costs. If you bill for more than your costs, don’t 
print this report—your client will wonder why you’re overbilling them.

■  Unposted invoices will print if they are part of the selection, but will be 
printed as “billing previews” until they are posted.

To print client invoices

1  Click on the Print Invoices button, or choose File > Print Invoices.

The Print Invoices window lets you select a batch of invoices selected by 
invoice number (e.g., 6006 - 6015), one particular client, and a range of 
invoice dates. The currently display invoice’s number is entered by default, 
but can be changed.

2  Enter a range of invoice numbers and an optional client number.

Printing Invoices

Printing Invoices

Any invoice numbered within the range of numbers you enter will be printed 
(or reprinted, in some cases). Enter a client number to print only invoices 
added for one client; the option is useful when a client asks for a reprint of 
the month’s billings.

3  Enter an optional range of invoice dates and options.

The currently displayed 
invoice’s date is entered 
by default. Use this option 
only when you need to print 
a set of invoices added on 
the same day or within the 
same time period. 

Use the print invoice detail 
report option to include a 
copy of the job cost report 
with each invoice. Since job 
costs and billing amounts 
are linked, your clients can 
easily see the costs billed 
specifically on an invoice. 
The Invoice Detail Report 
shows gross amounts only, 
so clients won’t actually 
see what the agency paid 
for the job’s costs.

Since each invoice can contain up to five distribution names, up to five 
copies of an invoice can be printed automatically. Since laser printers don’t 
handle multi-part forms, Clients & Profits X prints the distribution name (e.g., 
Acct Exec, Client, Job Jacket, etc.) at the bottom of each invoice. The print 
distribution copies option should be unchecked when printing invoices on 
multi-part forms to high-speed dot-matrix printers.

4  Click Print.

■  Since an invoice can be reprinted many times, be careful not to mail out 
duplicate copies of the same invoice just because it printed again.  
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The printed invoice

Invoice

Corporate Communications
7405 Von Karmen Avenue
Los Angeles  CA  90012

Don Gibbs Number 11027
Audience Technologies Inc. Date 01/01/07
200 Long Canyon Job Number ATT-150
Palm Springs  CA PO# --
93029 Charge# --

Job Name: Reseller Channel Web Site
Agency Exec. Tammy Burns
Description: Monthly web site managment - Reseller Channel web site

Description Hours Billed Amount

Creative Concepting 8.00 $800.00
Copywriting 5.00 $500.00 *
Creative Subtotal: 13.00 $1,300.00

Photography 5.00 $750.00 *
Production Subtotal: 5.00 $750.00

Computer Graphics/Programming 15.00 $1,500.00 *
Fulfillment Subtotal: 15.00 $1,500.00

Project Management 2.50 $225.00 *
Account Management Subtotal: 2.50 $225.00

SUB-TOTAL: 35.50 $3,775.00

*7.7500% State Sales Tax: $230.56

TOTAL: 35.50 $4,005.56

PAYMENT TERMS: Net 15

Thank you for your business and prompt payment!
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General Ledger

Clients & Profits X is built around a one-write, double-entry general ledger.  
This comprehensive, accrual accounting system automatically tracks your 
income, costs, and expenses using a custom, user-defined chart of accounts. 
Your G/L accounts track activity totals for 24 accounting periods (15 in C&P 
Classic). The system provides agency-tailored financial statements, including 
income statements, balance sheets, trial balances, detailed general ledgers, 
journals, and audit trails.

The General Ledger is used for 
financial accounting. This is 
different than job account-
ing, which deals with costs, 
billings, and expenses from 
the job’s point-of-view. The 
General Ledger consolidates 
all of the work you do—both 
job costs and overhead 
expenses—to provide a true 
look at the shop’s net income.  

■  Clients & Profits X has ev-
erything you need to produce 
financial statements, so it 
replaces any existing account-
ing systems you may be using. 
You do not need additional 
software programs to manage 
your books.

Unlike other systems you may 
have used, not everything 
affects
your general ledger. In fact, 
only those transactions that involve 
actual money (such as purchases, 
checks, and client payments) update 
the G/L; job costs (such as time, out-
of-pocket expenses, and purchase 
orders) do not affect your financial 
statements. This is important to 
understand, since it determines how 
you’ll manage your books with 
Clients & Profits X.

Financial reports provide comprehensive auditing and analysis information.  
Financial accounting takes into consideration every expense and income 
dollar in the shop, not just job profitability.  Overhead  expenses, salaries 
and miscellaneous income are included on the Income Statement along with 
job-related transactions. Assets, accumulated depreciation, liabilites, and 
equity are reported on the Balance Sheet. Audit trails, journals, and ledgers 
help track the transactions included in the financial statement calculations.  
General ledger account budgets are easily added and printed to analyze the 

General Ledger

account activity more closely. 
 

Automatic vs. manual journal entries

Journal entries are added to the General Ledger automatically when payables, 
receivables, checks, and client payments are posted.  Invoices that you enter 
into Accounts Payable, billings that you enter into Accounts Receivable, 
checks that you write in the Checkbook, deposits that you enter into Client 

Payments, and employee 
expense reports that you 
enter into Expenses are 
distinct records. Each record 
creates a separate journal 
entry into the General Led-
ger.  So when you see 
a G/L report, you are actu-
ally looking at the journal 
entries—not the source 
records, such as the invoice.  

Any manual entries you 
make directly into the Gen-
eral Ledger appear on G/L 
reports; they won’t appear 
on payable, receivable, or 
cash reports.  This gives you 
the f lexibility of manag-
ing your cost accounting 
apart from your financial 
accounting.

Profit centers and departments

Profit centers are set up to track a division’s finances and each profit center 
has its own chart of accounts. The profit center’s financial statements include 
only general ledger numbers that are assigned to that profit center. The profit 
center’s transactions post to the G/L like any other accounts.  The only dif-
ference is that the option can be chosen to print financial statements for only 
those accounts.  There’s no limit to the number of profit centers which can 
be set up.

Departments are used to track costs incurred by a group of staff members 
(e.g., the Art Department). Separate expense accounts are set up for each de-
partment and are distinguished by a two digit code that follows the account 
number. Each account is listed separately on financial statements unless the 
roll-up option is used.

The General Ledger window displays 
journal entries from A/P, A/R, the 
Checkbook, and Client Payments as 
well as manual entries you’ve made 
directly into the G/L. Use the toolbar 
buttons to find, add, edit, delete, 
and print journal entries. The Print 
button is a shortcut to printing 
G/L reports, which show debit and 
credit entries by reference number.
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Clients & Profits X is a single accounting system, so there are no complicated modules to 
integrate, maintain, or close. 

When someone adds a vendor invoice, check, client invoice, payment, or employee expense 
report, Clients & Profits X posts debit and credit journal entries into the General Ledger 
automatically. Standard (“default”) debit and credit account numbers are entered automati-
cally, too,but can be changed. This gives users the f lexibility they need to accurately account 
for all kinds of billings, costs, and expenses. In addition, general journal entries can be added 
directly into the General Ledger.

The entries users make don’t update the G/L until they are posted. Each user can double-
check their own work before posting using proof lists. Proof lists show the debits and credits 
for each transaction they added.

Any vendor invoice, client invoice, check or employee expense report can be coded with one 
or more job numbers and tasks. This tells Clients & Profits X to update the job ticket as well as 
the General Ledger. Because the accounting system is integrated with job tracking, there’s no 
double-entry. 
 
In addition to job costs, all kinds of overhead expenses are tracked by Clients & Profits X. 
Overhead invoices and checks can debit many expense accounts (and can even be split be-
tween job cost and overhead G/L accounts). 	

The General Ledger is updated every time an invoice, check, or payment is posted, so financial 
reports are also up-to-the-minute accurate. No month-end closing is required to print financial 
statements or aging reports.

Clients & Profits X can have two fiscal years open simultaneously. Fiscal years are customiz-
able, so they can start at any time during the year. Accounting, job costing, and financial 
analysis reports can be printed for any accounting period.

The chart of accounts supports hundreds of separate G/L accounts. A separate set of accounts 
can be created for profit centers or departments for better accountability. Each account can 
have up to a 9-digit account number, as well as customizable class, sub-class, cash flow, and 
ratio category settings.

Built-in auditing and reporting tools make it easy to analyze, query, and troubleshoot your 
accounting. Detailed audit trails and journals can show journal entries for any time period and 
for a range of accounts. The innovative Auditor lets you verify your General Ledger quickly and 
easily.

Clients & Profits X can handle dozens of different profit centers. Profit centers are integrated 
with jobs, tasks, staff members, and clients for better accountability. Financial statements can 
be printed for one profit center or for all profit centers. Departmental G/L accounts can be set 
up and used within a profit center for better cost tracking and analysis.

Monthly budget amounts can be entered for every G/L account, reducing the need for separate 
budget spreadsheets. Budget amounts can be reviewed on-screen or printed for any account-
ing period or quarter.

G/L Features

Feature How it works, how it’s used

 

One-Write, Double-Entry G/L

Automatic Journal Entries

Posting With Proof Lists

Integrated Job Costing, Billing

Overhead Accounting

Real-Tme Financials

24 Accounting Periods

Chart of Accounts

Auditing Tools

Profit Centers, Departments

Budgeting	
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Chart of Accounts

The Chart of Accounts contains your G/L accounts. These accounts are the 
basis of your accounting system, keeping monthly totals of income, costs, 
expenses, assets, and liabilities. The balances that appear on income state-
ments, balance sheets, trial balances, and other financials are based on the 
account totals in the Chart of Accounts.

The Clients & Profits X chart of accounts is completely customizable. You 
can have as few or as many accounts as you need (there’s no real limit to the 
quantity of accounts). Each account has an account number, classification, 
sub-class, and categories for cash flow and ratio reports. Separate accounts 
can be set up for different profit centers and departments. Every account 
keeps real-time running balances for up to 24 accounting periods (15 in C&P 
Classic).  

Budget amounts can be quickly set up for any or all accounts and periods 
using last year’s totals. Account totals can roll up into other accounts. The 
accounts are set up with the rollup information in the Chart of Accounts.  
Choose the Rollup option when printing financials to rollup, or hide, the 
account totals in the designated account. Accounts can also be made 
confidential. Confidential accounts work like regular accounts, but can’t be 
used by non-managers. They don’t appear on the printed account list or the 
lookup list.

You can add, edit, and delete accounts from your Chart of Accounts anytime 
(except for accounts with activity). Accounts with activity can be edited 
(except the number) and reclassified, but not deleted.

Account numbers

There are no rigid rules about numbering G/L accounts, although the number 
has a limited length (9-digits, which includes a decimal point and  2 decimals 
places to indicate the account’s department). You choose your own account 
numbers, so you can use any numbering system that conforms to account-
ing standards. Also, the same account number can’t be used twice. Account 
numbers are numeric, so they can’t contain letters or characters (i.e., dashes, 
etc.). An account number can’t be changed if the account has activity (i.e., 
journal entries) or a balance. Account numbers can’t contain leading zeros 
(e.g., 001000).

Account classes, subclasses, and profit centers

Accounts are categorized three ways: a major classification (e.g., asset, 
liability, sales, etc.), a subclass (e.g., current assets, fixed assets, etc.), and 
a profit center. The class organizes accounts as assets, liabilities, equities, 
sales, costs, expenses, other income, or other expenses.  Asset, liability, and 
equity accounts appear on the Balance Sheet. Income (billings), costs, ex-
penses, other income, and other expenses appear on the Income Statement. 
All accounts appear on the Trial Balance and the Detailed General Ledger. 
The classifications themselves are fixed, but their names can be changed in 
Preferences.

Chart of Accounts

Accounts are subtotaled within each class using a subclass. Subclasses 
are optional and user-defined, so you can create as many as needed. 
An account’s subclass can be edited anytime. Each account can belong to 
one profit center and one department. Profit centers are user-defined, so you 
can create as many as needed. Financial statements can be printed for one 
profit center at a time, or all profit centers.

Default accounts

Clients & Profits X has the ability to pre-program standard, or default, ac-
counts into your database. These default accounts are entered automatically 
when payables, checks, receivables, and client payments are added.  Default 
accounts can be overridden by simply entering an account number when 
a transaction is added. Default account numbers can be entered for these 
accounts: Cash/Checking; Accounts Receivable; Accounts Payable; Client 
Retainers; Billing/Income; Employee Advances*; Media Accruals*; 
Media Costs*; Overhead Expenses; Retained Earnings; Advance Billings*; A/R 
Discount Given; and, A/P Discount Taken.  Default G/L accounts are optional, 
but can help make your accounting more consistent and reduce errors. The 
default account numbers are entered in the G/L accounts Preferences win-
dow.  *not available in C&P Classic

Year-to-date net income, retained earnings 

The Year-to-Date Net Income and Retained Earnings accounts are necessary 
to your financial statements. The year-to-date net income account (which is 
always 999999) is calculated each time a financial statement is printed.  The 
account’s balance is always the income less costs and expenses. While the 
account number can’t be changed, you can name the account whatever you 
want. You can’t post entries directly to the YTD income account; instead, 
entries should be posted to income, costs, expenses, or Retained Earnings.

The Retained Earnings account tracks net income (or loss) from the previous 
accounting years. It’s an equity account of your choosing. The account is only 
used at year-end closing and for adjustments. Unlike the year-to-date net in-
come account, you can post journal entries to the Retained Earnings account 
when you need to adjust last year’s ending balances.

The Suspense account

The Suspense account (999998) is updated when the program isn’t able 
to find the account entered on the transaction. It’s an important account 
because it acts as a safety net when the wrong account, or no account, is 
entered. When entries are found in the suspense account, they are reversed 
out of suspense and into the correct account.
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The Chart of Accounts window

1  Use these tool bar buttons to 
scroll through the previous and next 
G/L accounts.

2  G/L accounts can be added, 
edited, budgeted, or deleted from 
the Chart of Accounts window.  
To add a new G/L account, click 
on the add button.  To edit a G/L 
account’s information, click on the 
edit button.  An account’s budget 
can be added, edited, viewed, or 
deleted by clicking on the edit bud-
get button.  The Monthly Budget 
window shows you the  monthly 
totals for this year and last year, as 
well as the budget for the selected 
G/L account. To delete an account, 
click on the delete button.  If an 
account has a balance or journal 
entries posted against it, it can’t be 
deleted.  Instead, you can  make 

the account inactive.

3  To print a hard-copy of the 
account list, click on the print but-
ton.  The list shows each account’s  
number, name, class, subclass, and 
profit center.

4  Enter an account number here to 
find a G/L account.  

5  Clicking the view history link 
let’s you quickly view and print all 
G/L entries for a selected account.  
All periods with activity appear 
and the debits and credits are 
subtotaled.  Then the period is 
reported.  The account’s balance is 
calculated at the end of the report.  
Each transaction’s date, reference 
number, and description are also 
given.   

6  Profit centers, sub-classes, and 
budget worksheets can be added, 
edited, viewed, and deleted from 
the Chart of Accounts window.  
Clicking on the profit centers link 
opens the Profit Centers window, 
where you can add, edit, and delete 
PCs.  Profit centers are used to 
track the financial performance 
of different parts of your business 
without maintaining a separate 
set of books.  Click the subclasses 
link to add, edit, delete, and print 
account sub-classes. Subclasses 
are used to arrange and subtotal 
accounts on financial statements. 
Examples of standard subclasses 
are Current Assets and Long-Term 
Liabilities. An account can belong 
to any (but only one) subclass.  
Click on the budget worksheet link 
to enter or edit the budget for the 

year.  All the G/L accounts and 
periods are displayed.

7  Double-click on the account 
class to view its accounts. G/L 
accounts are listed numerically by 
account number with their name/
description, profit center, and 
sub-class.    
8  Double-clicking on an account 
lets you change the G/L account 
information, such as its name. G/L 
accounts are added, edited, or 
deleted in the Chart of Accounts 
window only. 

q

y

w e

r

t

u i

o



72

Snapshot Reports

Snapshot reports provide a simple way to see essential information about 
the business. The idea behind snapshot reports is simple: Snapshot reports 
are designed to give managers quick “snapshots” of jobs, costs, billings, and 
financial information that are easy to print without programming. 

Snapshot reports summarize data from all parts of Clients & Profits X:  Pro-
duction reports show status, traffic and schedules from jobs and tasks.  Work 
in Progress reports show estimates, costs, and to-be-billed amounts from 
jobs and tasks.  Job Cost reports summarize purchases, time, expenses, and 
checks by job, task, or client.  Vendor Account Aging reports show unpaid 
invoices from Accounts Payable.  Client Account Aging reports show unpaid 
invoices from Accounts Receivable. The Cash Flash window shows the current 
cash status—the current cash balance and outstanding account balances 
for A/R and A/P. Productivity reports show how time was spent from Time 
Sheets. Profitability reports show profit and loss from jobs and tasks. Finan-
cials are financial statements printed from your General Ledger.

The snapshot reports are f lexible, offering many options for selecting, sorting, 
and printing data. Snapshot reports do not replace reports found in the Job 
Tickets, Accounts Payable, and other windows; instead, they work together to 
give you the most complete picture possible of your work.

Printing snapshot reports is easy: Simply choose a command from the Snap-
shots menu, make your selections, then click Print. Report options determine 
how data will be selected, sorted, and printed. Your report can be printed 
to the window (for a quick on-screen review of the data), to the printer, or 
to disk as a word processor text file. Every snapshot window lets you select 
from various options, all of which make your report slightly different. That’s 
why there isn’t really one “snapshot” report for production, for example; 
different versions of the same basic report let you somewhat tailor the report 
to your exact needs. Some snapshot windows have more options than others, 
depending on what’s being printed.

■  Anyone can print snapshot reports if they have the proper access privi-
leges. If a user has access to a particular snapshot window, he or she can use 
any of the window’s reports and options.  

Snapshot reports vs. other reports

Snapshot reports consolidate data from all parts of your Clients & Profits X 
database, such as job tickets, accounts payable, time sheets, checkbook, and 
accounts receivable. They specialize in summarizing mammoth amounts of 
data into clear, concise reports.  

Snapshot reports use the same data as reports printed from Job Tickets,   A/P, 
A/R, etc. So you’ll see the same data on a job summary printed from Job 
Tickets as you would on a Snapshot report. The difference is the snapshot 
report shows many jobs—while a job report from Job Tickets usually shows 
one job ticket.  

The record-by-record detail for a snapshot report can always be printed 

Snapshot Reports

separately. The individual time entries in a Productivity report, for example, 
can be printed as time reports from Time Sheets. Or, the journal entries that 
comprise the totals on your Balance Sheet can be printed in audit trails from 
the General Ledger.

Tips for printing snapshot reports

■  Printing reports to the window is faster than printing to the printer.  You 
can review a report quicker when it’s on the window, since it doesn’t have to 
wait for the printer or the network.  Once in the window, you can print one 
page or all pages using the Print pop-up menu at the top-right corner of the 
window.

■  Every snapshot window features a variety of options which affect how 
data appears on reports.  This means you may get slightly different results 
when printing the same report over again.  When you’ve finally discovered 
the right combination of options on a report, make a note on the report of the 
option you’ve chosen.  So whenever someone else needs the same report, 
they’ll know the right options to use.

■  Managers can prevent users from printing certain kinds of snapshot 
reports by changing their access privileges:  Choose Users, Access, and 
Privileges from the Setup menu; from the Menus access options, uncheck the 
snapshot reports the user shouldn’t print; click Save.  These changes will take 
affect the next time the user introduces himself or herself.

■  Any snapshot report can be printed to a disk as a text file.  The text file, 
however, is unformatted (no fonts or styles).  It can be opened by any word 
processor, but not a spreadsheet, then edited as needed.
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The Snapshots menu

Snapshots Reports

1 Production reports show status, 
traffic and schedules from jobs and 
tasks. It’s the only way to get job 
status lists, traffic reports, and job 
schedules for all of your jobs in 
production. Jobs can be selected 
by production or billing status. 

2 Work in Progress reports compare 
estimates, costs, open purchase 
orders, and unbilled costs from 
jobs and clients. 

3 Job Costs reports summarize pur-
chases, time, expenses, and checks 
by job, task, or client—every cost 
you’ve incurred for a week, month, 
or any period by client, job, or task. 

4 Vendor Account Aging reports 
show unpaid invoices from A/P. You 
can see unpaid invoices in detail, 
or just see each vendor’s balance 
due. The vendor aging can be run 

as of the current date or through 
any prior period. Client Account 
Aging reports show unpaid invoices 
from Accounts Receivable. You can 
see each unpaid invoice, or just the 
total balance due for each client. 
Invoice aging reports have many 
options; for example, you can print 
an aging for one client or for all cli-
ents within one division. The client 
aging can be run as of the current 
date or through any prior period.

5 The Cash Flash window shows 
your current cash balance and 
outstanding A/P and A/R balances. 
A schedule of payments and cash 
receipts can be set up to help you 
plan your cash needs.

6 Profitability reports show profit 
and loss from jobs and tasks. You 
can analyze the job’s profit to date, 
or just profit earned for the month’s 

billings and costs.

7 Productivity reports show how 
time was spent from Time Sheets. 
You can quickly see how your staff 
is utilizing their time by client, 
department, or profit center—for 
a week, a month, or any period of 
time. There are reports to analyze 
overtime and show you which staff 
members have not accounted for all 
their hours.

8 Financials include the Income 
Statement, Balance Sheet, Trial 
Balance, Detailed General Ledger, 
and Statement of Cash Flows. 
You can print financials anytime 
during the month, seeing your 
up-to-the-minute balances. The 
financials can be run for any of the 
24 accounting periods or quarterly 
financials can be run. 

y

i

o

u

q

w

r

e

t

9  Media Analysis reports can be 
used by media buyers and account 
service to see how advertising was 
purchased.  Account management 
can use media analysis reports to  
analyze how well the media depart-
ment is managing themselves.
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Production Reports

Production reports are your best source of up-to-date information on 
open jobs, traffic, and task schedules. A complete picture of your work 
in production is available here: job status lists, traffic reports showing mile-
stones, work-to-do schedules for tasks and resources, and a customi-
zable schedule chart that shows selected unfinished tasks.

The Job Hot Sheet reports show jobs by production status, sorted by job 
number. Each job shows its 
job number, job name, cli-
ent, and status. The Job Hot 
Sheet can show jobs select-
ed for a range of start dates, 
due dates, added dates, or 
closed dates. It’s like the job 
lists you can also print from 
the Job Ticket window.

Traffic reports show jobs 
by production status, and 
feature milestones. Jobs are 
grouped by job type, so that 
like jobs are shown together. 
The traffic reports can be run 
for one client, AE, or one of 
six key production people. 
The job’s status note (which 
is a customizable status 
code entered in the job’s 
Traffic window) appears on 
the right side of the report. If 
you use FileMaker, this report is probably very similar to the job report you’re 
now using. 

Schedules/work to do reports show unfinished job tasks by resource, client, 
AE, department, or task. These work-to-do reports can be printed daily to 
show everyone what they’re to do each day. Or, weekly schedules can be 
printed in advance for production meetings to help manage the week’s work 
load.

The schedule chart is a combination traffic/schedule report. It charts a 
user-defined selection of tasks by due date. You can pick-and-choose the 
unfinished tasks you want to see, sorted by job number. You can also sort the 
unfinished tasks by client. So instead of seeing every unfinished task for the 
week, you can print just ART, COPY, and DES (i.e., design) instead. Any com-
bination of tasks can be charted. This ability lets you easily chart work-to-do 
for different work groups, such as creative teams. For f lexibility, the chart’s 
title is even customizable.

The analysis reports allow you to see which tasks were completed on time 
and which were late, or a list of missed deadlines can be printed for each 
staff member

Production Reports

■ Each of the production reports has its own unique purpose. You may not 
need every one to help you manage your jobs. Instead of printing every 
report, experiment with each report (and its various options) to see which one 
gives you the best information you need to keep track of jobs.

To print production reports

Each production report has 
its own selections, which 
don’t affect the other 
reports. For example, you 
can print a status report 
listing jobs with status 
1-50, while also printing a 
traffic report showing jobs 
with status 1-999. 

1  Choose Production from 
the Snapshots menu.

2  Select the kind of report 
(i.e., Hot Sheets, Traffic, 
Schedules/Work to Do).

3  Make your report selec-
tions.

4  Click Print.

Production reports with more information will take longer to print than 
shorter reports.

Tips for printing production reports

■ Use the Job Hot Sheet as your basic production report. Since it shows the 
job’s key facts—job number, job name, client, due date, production status, 
and status notes—it’s a great way to see your open jobs at a glance. If you 
need to see more detail about a job, print a job summary (from Job Tickets).

■ Production reports are less detailed than regular job reports. Job lists 
printed from Job Tickets, for example, include many more options (such as 
showing the job specifications). However, other job reports are longer since 
they show more information. This makes them a little more complicated, 
since there are more pages used.

■ Don’t use production reports for billing. Since production reports are 
designed to manage work in production, you won’t see estimates, costs, 
billing, or other amounts. Instead, print either Work in Progress reports (from 
Snapshots) or job lists and job summaries (from Job Tickets).
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Production Reports

Production Reports

Job Hot Sheet

Traffic Hot Sheet

Traffic by Job Type

Traffic by Client

Traffic by Job Number

Traffic by Production Status

Traffic by AE/Team

Work to Do (by Due Date)

Work to Do (by Start Date)

Daily Task Calendar

Client Deadlines

Department Task Checklist

Job Schedule

Schedule Chart

On-Time Performance

Missed Deadlines

The Job Hot Sheet shows the job’s key facts—job number, production status, and status notes.

The Traffic Hot Sheet shows the job’s number, production status, and traffic assignments.

The Traffic by Job Type report lists each job within a job type and shows each jobs’ milestones 
and status notes. Each job type prints on a separate page.

The Traffic by Client report lists each clients’ jobs by job type, showing the jobs’ milestones. A 
separate page is printed for each client’s jobs.

The Traffic by Job Number lists each jobs’ milestones and sorts the jobs within each job type by 
job number. 

The Traffic by Pruduction Status lists each jobs’ milestones and sorts the jobs within each job 
type by production status code.

The Traffic by AE/Team lists job milestones and sorts the jobs within each job type by AE/Team.
 

The Work to Do report (by Due Date) shows unfinished tasks by due date and sorts by resource.

The Work to Do (by Start Date) shows unfinished tasks by start date and sorts by resource.

The Daily Task Calendar gives a checklist of unfinished tasks by due date. The client, job, 
resource, and time of day each task is due is listed with a check box so the printed report can be 
used as a manual checklist.

The Client Deadlines report shows unfinished tasks for each client and sorts them by due date. 
The job number, job name, resource, and time due are listed for each task.

The Department Tasks Checklist shows unfinished tasks for each department, sorted by due date. 
The task’s due date, time due and resource are shown along with the resource’s backup person.

The Job Schedule report gives a list of unfinished tasks by start or due date.  For each task the 
estimate hours and hours remaining are shown.

The Schedule Chart lets you choose the unfinished tasks you want to see and sorts them by job 
number or client. So instead of seeing every unfinished task for the week you can print just a 
select few (e.g., artwork, copywriting,and design).

The On-Time Performance report compares the due date of each client’s unfinished tasks to the actual 
date the task was finished. The number of days the task was late is calculated and the performance of 
meeting the due dates is analzed by showing what percentage of the tasks were early, on-time, late, or 
very late.

The Missed Deadlines report shows tasks that were finished after the scheduled due date for each 
person. The number of days the task was late is calculated.

Production Hot Sheets

Traffic Reports

Schedule/Work To Do Reports

Schedule Charts

Production Analysis Reports
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Work in Progress Reports

Work in progress reports are based on jobs and tasks—and not general ledger 
journal entries. Unlike older agency accounting systems, the general ledger 
does not automatically track your unbilled costs. This is done for two reasons: 
(1) Clients & Profits X can track costs and billing without needing the General 
Ledger, which other systems can’t; and (2) only actual costs and billings af-
fect the general ledger anyway.

Here’s how it works: When a vendor invoice or check is added, every line 
item gets a debit account (typically a job cost or expense). During post-
ing, the line item amount debits the general ledger—increasing the cost or 
expense account’s balance. 
The entry is counted as a 
cost against income immedi-
ately; it is not counted as an 
asset. When the job is billed, 
an income account is credit-
ed and Accounts Receivable 
is debited—that’s all. Billing 
does not affect your cost or 
expense accounts.

Here’s why: The system 
assumes that you’ll bill 
costs in the same period 
that they’re entered. It’s 
simpler, since agencies can 
bill costs more quickly now 
with Clients & Profits X. 
This eliminates the need to 
initially post costs to WIP, 
then reverse the costs that 
were later billed. So instead 
of booking the month’s costs 
as they’re added, you only need to make a month-end entry for the value of 
unbilled costs. And you’ll get this amount from the work in progress reports.

This method of cost accounting only applies to payables and checks. 
Purchase orders, insertion order, time sheets, out-of-pocket expenses, cost 
transfers, and job change orders don’t post journal entries into the general 
ledger Work in progress reports summarize unbilled costs. These reports are 
the best way to see what you’ve spent on jobs so far, even if they’ve been 
billed before. Work in progress reports can show what’s to be billed by client, 
making the month’s billing easier. Other reports help you account for your 
change orders.

The various work in progress reports show jobs, tasks, and costs in differ-
ent ways, so have different purposes. The Billing Hot Sheet report is a great 
pre-billing report, since it lists your unbilled jobs by client. It summarizes the 
unbilled totals by job, so it is a very compact report; however, it doesn’t show 
much detail.  

Work in Progress Reports

WIP reports can show jobs, tasks, and costs for one client, AE, project, or 
profit center by using the select by pop-up menu. They can show unbilled 
costs by production status or billing status, letting you see only jobs marked 
as ready to bill, for example. By using billing status, accounting managers 
can print their own reports.

Change orders aren’t costs, so don’t appear on the work in progress reports. 
Since they may influence a month’s billing, change order reports and forms 
can be printed from the Work in Progress window. The Change Order Report 
lists change orders for all jobs for a range of dates. The option change orders 

prints a list all change 
orders for a time period.

■ Tasks without unbilled 
costs aren’t included on 
work in progress reports. 

Billing worksheet report 
options include:

■ Include overbilled tasks. 
Only unbilled tasks appear 
on WIP reports. Over-billed 
tasks (which may have been 
billed by estimates) aren’t 
included. Why exclude over-
billed tasks? These amounts 
will decrease the unbilled 
total for the job, and you 
may not bill enough to cover 
the job’s actual costs. Since 
the job summary and job 
progress reports show all 

tasks, you should use this option if you compare them with work in progress 
reports. 

■ Show overbilled jobs. This option looks at the unbilled total of the job, 
rather than the individual tasks. If the unbilled total on the job is a negative 
amount (i.e., the job is overbilled), then the job will not appear on the report 
unless this option is selected.

To print work in progress reports

1  Choose Work in Progress from the Snapshot menu.

2  Select the kind of report (i.e., Billing Worksheets, Unbilled Costs, Unbilled 
Media..etc).

3  Make your report selection.

4  Click Print.
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Work in Progress Reports

Work in Progress Reports

Billing Hot Sheet

Job Billing Worksheet

Unbilled Costs by Job

Unbilled Costs by Task

Partially-Billed Costs

Costs On-Hold

Unbilled Media (all kinds)

Unbilled Broadcast Orders

Unbilled Insertion Orders

Write-offs

Markdowns

Overbilled Tasks

Unbillable Costs

G/L Accrual (Costs by dGL)

Change Orders

The Billing Hot Sheet shows unbilled jobs by client—including each job’s estimate (plus 
change orders), billed, and remaining unbilled amounts. A checklist of the billing workflow 
steps is listed for each job.

The Job Billing Worksheet shows unbilled jobs and their tasks—including each task’s budget, 
costs, commitments, billings-to-date, and a space to enter the amount to bill now. Every job is 
printed on its own page, making the report easy to distribute to AEs. 

The Unbilled costs by Job report can be selected by cost status. This option lets you see unbilled 
costs that are on-hold, for example, or cancelled. All other costs will be excluded from the report.

The Unbilled Costs by Task report lists unbilled vendor purchases, time entries, expenses, checks, 
and transfers by task. Use this to easily see total unbilled printing, layout, etc. at month-end. To 
see unbilled costs for a time period, choose Job Costs from the Snapshots menu.

The Partially-Billed Costs report lists any cost with a status of Partial. The costs are sorted 
by client, then job.

The Costs On-Hold report lists any cost with a status of On-Hold.

The Unbilled Media (all kinds) report lists all insertion and broadcast orders that have not been 
billed to the client. The orders are grouped by client and sorted by order number.

The Unbilled Broadcast Orders lists all broadcast order not yet billed to the client. Each 
broadcast order is listed with its station, flight dates, number of spots, and net and gross 
amounts. A separate page is printed for each client’s orders.

The Unbilled Insertion Orders lists all insertion orders not yet billed to the client. Each in-
sertion order is listed with its publication, issue date, ad size, and gross amount. A separate 
page is printed for each client’s orders.

The Write-offs report analyzes costs that have been written off for some time period.

The Markdowns report shows costs that have been billed for less than their gross amounts.

The Overbilled Tasks lists job tasks that have been billed for more than their actual costs.

The Unbillable Costs report lists unbillable costs by job or task.

The G/L Accrual summarizes unbilled job costs by debit G/L# for making manual WIP entries.

The Change Orders report lists change orders added for any time period.

Billing Worksheets

Unbilled Costs

Unbilled Media

Analysis

Miscellaneous
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Job Cost Reports

Job cost reports are very detailed listings of vendor purchases (buyouts), time 
sheets, checks written for job costs, out-of-pocket expenses, and job cost 
transfers. 

Job costs are selected by work date (i.e., when the time was used, the 
vendor’s invoice date, or the date a check was written for job costs) or posted 
date. This makes it easy to see what you bought and where you spent your 
time for a week, month, or any time period. In addition, costs can be sorted 
by job number, client, or 
task for better analysis. 

The basic job cost report 
shows each cost’s refer-
ence number (i.e., invoice 
number, check number, 
time ID number), date, 
vendor or staff member, 
job number, task, hours 
(if it is a time entry), net 
cost amount and gross 
amount. As an option, you 
can show the cost’s notes.

You’ve got a substantial 
amount of control over 
how the report is ar-
ranged. Cost reports can 
be printed showing any 
combination of vendor 
costs, time entries, 
expenses, and cost 
transfers. 

Since costs are connected to jobs, you can print cost reports using status 
codes. You can select costs by the job’s production or billing status. This abil-
ity lets you see job costs, for example, for only open jobs. Or, you can print 
job costs for closed jobs, jobs on hold, etc. You can also show costs for one 
job number, one client, or one task. There’s no limit to how you can print job 
cost reports.

■ Purchase orders are not job costs (yet), but a purchase/insertion order 
report can be printed from the Job Cost Report window.

Job Cost reports vs. other cost reports

The Job Cost report is best for seeing costs for all jobs for some time period. 
But there are other reports that may be more useful in different situations, for 
different needs.

■ To see the costs for one job only: Choose View > Job Tickets then find 

Job Cost Reports

the job you want. Then choose File > Print Job Reports, select the job 
cost report, then click Print. This report prints all costs, regardless of 
date, including billing information. Costs can also be sorted by kind, instead 
of task.

■ To see time in detail by day: Choose Accounting > Time Sheets then 
choose File > Print Time Reports. Enter a range of dates, then click Print. 
Time reports show time by day, staff member, job, task, or client. In addition, 

you can print time entries 
by date added or date 
posted, unlike the Job 
Cost reports.

■ To see time totals: 
Choose Productivity from 
the Snapshots menu; enter 
a range of work dates; 
select some options; then 
click Print. The productiv-
ity reports summarize time 
sheets in various ways. 
You’ll see clear, concise 
totals and not all of the 
time detail, making it a 
very efficient, effective 
management report.

To print Job Cost 
Reports

1  Choose Job Costs from 
the Snapshots menu.

2  Select the kind of report (i.e., Job Costs, Client Job Costs, Task Costs..etc)

3  Make your report selections.

4  Click Print.

Tips for printing job cost reports

■ Only posted costs appear on Job Cost reports. Unposted costs, including 
unposted daily time cards, are simply excluded until they are posted.

■ If a user doesn’t have access to cost amounts, they will not be able to 
print Job Cost reports, so there’s no way for the user to see cost rates and net 
amounts.
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Job Cost Reports

Job Cost Reports

. 

Job Costs

Client Job Costs

Task Costs

Purchase Orders

Change Orders

The Job Costs report is simple, showing costs by job and task. All costs can be selected or any combi-
nation of outside costs, time, in-house expenses, or internal charges.

The Client Job Costs report shows costs by client, then by job number. 
A separate page is printed for each client. All costs can be selected or any combination of outside 
costs, time, in-house expenses, or internal charges. 

The Task Costs report shows costs by client first, then by job task. You’ll see how time and money was 
spent by client, task, and the vendor or staff member. A separate page is printed for each client, too. 

The Purchase Order report can be printed for one or all types of orders (broadcast, insertion, 
purchase).  Each order’s number, vendor, date, cost, gross, and balance is shown.

The Change Order report can be printed for approved or Unapproved orders.   Each change 
order’s number, date, description, and status are shown, along with the hours, budget, and 
estimate amounts being changed.

Job Costs

Client Job Costs

Task Costs

Purchase Orders/Insertion Orders

Change Orders
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Profitability Reports

There are many kinds of job profitability reports. Each report gets its infor-
mation from a different source, so each has a slightly different focus—and 
usefulness. The Job Profitability reports show costs, time, and billings for jobs 
and tasks. The Client Profitability reports are based on journal entries from 
the General Ledger, including overhead expenses you’ve directly allocated to 
clients, for one accounting period. The Gross Margin report compares costs, 
time, expenses, and billings for a week, a month, or any period of time—so 
it’s the most f lexible way to track your shop’s performance.

The foundation of the Job 
Profitability reports is the job 
task. Jobs remember every-
thing purchased and billed by 
job task. Job tasks keep job-
to-date totals for costs, time, 
expenses, and billings from 
the date the job was started. 
Since job tasks are connected 
to jobs and clients, they are 
an ideal basis for analyz-
ing profitability. Job-to-date 
profitability reports search 
for job tasks for a period of 
time (using the job’s start 
date) and billing status (such 
as closed jobs, for example). 
These tasks are rearranged, 
sub-totaled, and printed by 
job, project, client, task, etc. 
based on the options selected 
in the Profitability window. 
In most cases, the job tasks 
themselves are hidden to save space; what you see instead are just the job’s 
totals. These totals are based on the same job tasks you’d see in a Job Sum-
mary report.

■ The Job P&L and Client P&L, which is based on G/L journal entries from 
billing and job costs, is printed from Financials. Every journal entry can be 
given a client number and a job number. If a journal entry has a job number, 
it is selected for the job income statement. The Job P&L is printed for one 
accounting period, just like the agency’s income statement. It can reflect 
the client’s overhead allocation, if entered into the Overhead Allocation 
Worksheet. You can print the report for one job or one client.  The job income 
statement doesn’t show time, expenses, or any other amount not posted in 
the General Ledger—so it may be drastically different (and probably less ac-
curate) then the other profitability reports. 

The Gross Margin report compares costs and profit for any period of time, 
such as a month or a quarter. This report is distinctive because it shows 
profit both before and after labor. Direct costs are the total vendor purchases, 
checks, and expenses. Net Revenue is billings less direct costs. Direct Labor 

is the total time cost for the month. Profit is net revenue less direct labor. 
Jobs are sub-totaled by client for easy comparison. The last bill date is shown 
from the last invoice billed for the job.

Job profitability vs. agency profitability

You can see profitability two ways: Job profit is focused on job costs—vendor 
purchases, labor, cash disbursements from checks, and out-of-pocket expens-
es—and job billings. Agency profit is based strictly on income and expenses 

for everything—whether they 
were the result of jobs or not. 

You can’t rely on just one 
profit report to keep you 
informed. Job profitability and 
the income statement em-
phasize different things: job 
profitability reports are based 
solely on jobs, tasks, and 
clients; income statements 
are based only on the general 
ledger.

Job profitability shows only 
costs and billings for jobs and 
tasks, and does not account 
for overhead expenses like 
rent. Income statements don’t 
reflect the cost of time spent 
working on jobs, only the 
total payroll expense. Income 

statements take into account other non-job income, like fees and interest in-
come; job profitability doesn’t reflect adjusting entries to the General Ledger.

What’s the difference between gross margin and net income? Gross margin, 
as it is used in Clients & Profits X, is based on jobs and tasks. 
It is the difference between a task’s billings and its costs—vendor purchases, 
time sheets, and expenses. Net income, as it is used on the income state-
ment, is the agency’s real profit after overhead expenses.

Job Profitability vs. the Income Statement

Both reports show important information about how well you’re doing. Job 
profitability shows exactly where your revenue is being earned, even showing 
each client’s total contribution to profit. Income statements can’t 
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Profitability Reports

Profitability Reports

Gross Margin by Job

 

Projected Gross Margin

 
Projected vs. Actual Gross Margin

Gross Margin by Client

Project Profitability

Division Profitability

Client vs. Client Gross Margin

 
Comparative Client Profitability

Projected Gross Margin by Client

Gross Margin by AE/Team

 
AE/Team Projected Gross Margin

 
AE/Team Projected vs. Actual Gross 
Margin

Gross Margin by Profit Center

Profit Center Projected Gross Margin

Profit Center Projected vs. Actual 
Gross Margin

The Gross Margin by Job report compares costs and profit for each job, sub-totaled by job 
type. The net revenue is calculated based on the billings less direct costs, and the gross 
margin (or profit) is calculated by the net revenue less direct labor costs.

The Projected Gross Margin report calculates a projected gross margin based on the 
job’s estimate less the costs expected to be incurred to complete the job (i.e., budget).

The Projected vs Actual Gross Margin report compares the job’s actual gross margin to 
the projected gross margin. The job’s are sub-totaled by job type. 

The Gross Margin by Client report shows the net revenue for every client’s jobs.

The Project Profitability report compares gross margin for jobs within each project.

The Division Profitability report compares profit between divisions and their clients.

The Client vs Client Gross Margin report shows the costs and profit for each client and 
calculates each client’s net revenue and gross margin.  

The Comparative Client Profitability report compares this year’s and last year’s profit.

The Projected Gross Margin by Client report calculates a projected gross margin based 
on the job’s estimate less the costs expected to be incurred to complete the job (i.e., 
budget) and the jobs are subtotaled by client.

The Gross Margin by AE/Team report calculates the net revenue and gross margin for 
each job and sub-totals the jobs by AE/Team.

The AE/Team Projected Gross Margin report calculates the projected gross margin 
based on the job’s estimate less its budget. The job’s are sub-totaled by AE/Team.

The AE/Team Projected vs Actual Gross Margin report compares the projected gross 
margin to the actual gross margin for each job and sub-totals the jobs by AE/Team.

The Gross Margin by Profit Center report calculates the net revenue and gross margin 
for each job and sub-totals the jobs by client, then by profit center.

The Profit Center Projected Gross Margin report calculates the projected gross margin 
figure for each job based on the projected billings (the job’s estimate) less the costs 
expected to be incurred to complete the job (the job’s budget). The job’s are sub-
totaled by client, then by profit center.

The Profit Center Projected vs Actual Gross Margin report compares the projected gross 
margin to the actual gross margin for each job and sub-totals the jobs by client and 
PC.

Job Profitability

Client Profitability

AE/Team

Profit Center
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Productivity Reports

Productivity reports use time sheets to show how the shop’s time is spent. 
These reports are the best way see how people work—by client, job, or task. 
Productivity reports show the hours, cost amounts, and billable amounts 
for both billable and non-billable hours, so you’ll see a complete picture of 
your work.

Productivity reports show time by work date. Like time reports, productivity 
reports show hours posted 
from time cards and time 
sheets. But unlike time 
reports, productivity reports 
only show totals—so you 
won’t see individual time 
entries. This makes produc-
tivity reports much more 
concise (and probably more 
usable) than time reports.

Productivity reports don’t 
show billings. They’re less 
concerned with how the 
time was billed (or not 
billed) than with how the 
time was actually spent, 
since the cost of your staff is 
mostly fixed (unless they’re 
freelancers, that is). One rea-
son for printing productivity 
reports is to see how time is 
being used, and especially if 
is it being managed properly. 
One of the reasons to track productivity is to ensure that the right people 
work on the right clients (i.e., the higher-paid staffers should only work on 
the most profitable clients, etc.).

Productivity reports can also help you balance your work load. If one staff 
member is consistently logging more hours than other staff, you’ll see it in a 
their total hours—they’ll be higher than others. You can use this information 
to move work around, so that everyone is working more efficiently.  

Time reports vs. productivity reports

Productivity reports show time in summary, while time reports show time 
in detail. Productivity reports are designed to give managers a clear idea of 
how the staff spends their time over a week, month, quarter, or year. 

Time reports, in contrast, are designed for day-to-day time accountability. 
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Productivity reports 

The Daily Dept Time Analysis report shows total hours by day for everyone who worked, 
including planned vs. actual hours by day for each staff member and department.

The Weekly Time Summary report shows total hours spent for each staff member for a 
7-day period, sub-totaled by department.

The Weekly Time Analysis report shows total hours spent for each staff member and the 
jobs they worked on for a 7-day period, sub-totaled by department.

The Missing Time report lists each staff member by departement showing their planned 
hours vs. their actual hours. It shows who hasn’t accounted for all of their time.

The Overtime report shows time entries marked as “overtime” only.

The Staff Utilization report compares each staff member’s total hours vs. their billable 
hours. It is based on what percentage of their total hours is actually billable time.

The YTD Staff Utilization by Client report compares period vs. year-to-date staff time.

The Freelance Time Analysis compares client hours for employees vs. freelancers.

This report compares the percentage of unbillable staff time by client.

The Billable/Unbillable Time Summary report compares billable to unbillable hours. 

The Staff Realization report compares each staff member’s total hours vs. their billed 
hours.  It is based on what percent of thier total hours has actually been billed.

The Dept/Group Productivity report compares each staff member’s total hours vs. their 
billable hours. The staff members are sub-totaled by department.

The Team Productivity report compares each team’s total hours vs. their billable hours 
and calculates the team’s utilization (percentage of billable hours).

The Team/Staff Productivity report compares each staff member’s total hours vs. their 
billable hours. The staff members are sub-totaled by team.

The Monthly Client Time Summary report shows total hours worked by staffer per client. 

The Client Productivity by Job report shows total hours worked by job and client.

The Division Productivity report compares each division’s total hours vs. billable hours.

The Division/Client Productivity report analyzes total hours for each division and client.

The Division/Staff Productivity report compares staff hours by division and client

Daily Department Time Analysis

Weekly Time Summary

Weekly Time Analysis

Missing Time

Overtime

Staff Utilization

YTD Staff Utilization by Client

Freelance Time Analysis

Unbillable Time Analysis

Billable/Unbillable Time Summary

Staff Realization

Dept/Group Productivity

Team Productivity

Team/Staff Productivity

Monthly Client Time Summary

Client Productivity by Job

Division Productivity

Division/Client Produtivity

Division/Staff Productivity

General

Dept Performance

Client AnalysisClient Analysis

Staff Utilization
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Financials

Clients & Profits X prints standard financial statements tailored especially for 
the advertising industry. These financial reports are used for auditing, track-
ing, and reporting your G/L accounts balances. You can print trial balances, 
income statements, balance sheets, and detailed general ledger reports for 
any accounting period—at any time during the month.

Financial statements show account balances from the General Ledger and 
the Chart of Accounts. These account balances are updated when entries are 
posted, so the financial statements are always timely and accurate whenever 
they’re printed. 

The account totals on the 
financial statements are 
copied from the Chart of Ac-
counts. To see one account’s 
totals: Choose Setup > Chart 
of Accounts. Click once 
on an account to select it, 
then choose Edit > Monthly 
Budgets. The center column, 
actuals, is the total from 
posted entries. Entries added 
in the General Ledger affect 
financial statements when 
they’re posted. Unposted 
entries won’t appear on 
financial reports. 
Be sure to post everything 
before printing financial 
statements.

■ Only manager-level us-
ers can print financials. There is no month-end procedure required to print 
financials. Since the G/L account balances are updated whenever entries are 
posted, your financial statements will always be up-to-date throughout the 
month.

The AGI Income Statement

The income statement shows the agency’s profit and loss. There are two 
kinds of income statements, the standard form and the agency gross income 
form. Both forms show the same accounts, but have different sub-totals. 
These sub-totals affect how the percentages are calculated.

The standard income statement sub-totals income accounts, job cost ac-
counts, and expense accounts. Gross profit is calculated as billings minus job 
costs. A gross profit percentage is calculated showing job costs as a fraction 
of the total billings. An account can appear in the income or job cost section, 
based on its classification (which is user-defined). Expenses are listed below 
the gross profit. The expense percentage for each overhead account is calcu-
lated as a percent of the billings, not gross profit. This calculation shows your 
ratio of overhead to total billings.

The AGI income statement combines your billing and job cost accounts into 
the same section. The gross profit is calculated as the billings minus job 
costs (like media, typesetting, printing, etc.). This amount is your agency 
gross income. Expenses are listed below the AGI. The expense percentage for 
each overhead account is calculated as a percent of gross profit, not billings. 
This calculation shows the ratio of overhead to gross profit—the agency’s 
gross income.

To print financials

1  Choose Financials from 
the Snapshot menu.

2  Select the kind of report 
(i.e., Trial Balance, Detail 
G/L, Income Statement, etc.)

3  Make your report selec-
tion.

4  Click Print.

Tips for printing 
financials

■ Financial reports can be 
printed to the screen for 
quick review, before the 
report is committed to paper.

■ Financial statements can 
be printed for previous periods—even if the period is locked—by choosing the 
period from the pop-up menu. 

■ Unless a period is locked, anyone can post entries into prior periods. This 
means your past financials might change after they’ve been printed. If some-
one adds costs or billings after you’ve printed the month’s financials, be sure 
to reprint the reports over again.

■ Account totals on financial statements can be audited by printing audit 
trails and journals from the General Ledger. 

■ If your audit trails and journals don’t equal the financial statements, post-
ing may have crashed during the month. Use the verify G/L account balances 
utility to recover the correct totals.

■ The date and time a financial statement was printed appears at the top of 
each report. When you’re printing financial reports repeatedly, use this date 
to determine the most-recently printed report.
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Financial Statements

 

The Trial Balance shows assets, liabilities, equity, income, costs, and expenses. You’ll see each 
account’s beginning balance, current balance, and ending balance. Assets, costs, and expenses 
have positive balances; liability, equity, and income accounts have negative balances.

The Detailed General Ledger report shows the period’s journal entries for each account. Each ac-
count includes its beginning and ending balances for quick reference. For easy auditing, journal 
entries can be printed for selected accounts.

The Income Statement shows income, job cost, and expense accounts as well as net profit/loss 
for the shop. The standard format shows gross profit as billings less job costs. It also shows ex-
pense ratios as part of total billings. The AGI format shows expense ratios as part of gross profit, 
not total billings. 

The Comparative Income Statement compares this years income, job cost, and expense 
accounts to the amounts from last year.

The Client P&L report shows billings, direct costs, gross profit, and gross profit by client. 
Unlike the Client P&L Analysis, it does not break out each client’s share of overhead.

The Client P&L Analysis shows each client’s income, costs, direct labor, direct expenses, 
plus their share of the overhead allocation. The net income earned is calculated by client.

The Job P&L shows billing, direct costs, expenses, and gross margin for one period.

The Balance Sheet shows ending balances for assets, liabilities, and equity. It shows your net 
worth.

The Comparative Balance Sheet compares assets, liabilities, and equity between two fiscal 
years.

The Statement of Cash Flows report uses each G/L account’s cash flow category to calcu-
late operating, investing, and financial activities totals for the period.

This report shows detail of the amounts on the Statement of Cash Flows. It is used to ana-
lyze the amounts use to calculate the totals shown on the Statement of Cash Flows.

The Media WIP Analysis report is used to audit balance of the Media WIP Accruals liability 
account, which is updated from media billing and vendor invoices.

The Liquidity Analysis report measures the ability of the company to meet cash require-
ments. It’s based on the ratio categories entered for each G/L account.

The Profitability Analysis report measures how well the company is utilizing its resources

The Solvency Analysis report measures how the company’s financial health with ratios such 
as debt-to-equity, cash flow to interest, debt-to-assets, and more.

Trial Balance

Detailed G/L

Income Statement

Comparative Income Statement

Client P&L

Client P&L Analysis

Job P&L

Balance Sheet

Comparative Balance Sheet

Statement of Cash Flows

Cash Flow Detail Report

Media WIP Analysis

Liquidity Analysis

Profitability Analysis
  
Solvency Analysis

Trial Balance

Detailed G/L

Income Statement

Balance Sheet

Ratios

Analysis
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Appendix A: Setting Up C&P E-mail

One of the best features in Clients & Profits X is the innovative use of 
internet-based electronic mail. It works with industry-standard SMTP-based 
mail servers to automatically send e-mail from Clients & Profits X to staff 
members or other e-mail address. C&P e-mail is sent automatically (such 
as when a job is opened or its status codes changes) or based on scheduled 
entries added by users.

Two things make C&P e-mail work: a SMTP server and e-mail addresses for 
each staff member. To start sending automatic e-mail, you’ll first need to 
enter the name of your SMTP 
server into Clients & Profits 
X. It must be a standard 
SMTP-based mail server, 
and not a proprietary server 
like ccMail, QuickMail, etc. 
(unless you’re using a newer 
version that speaks SMTP). 
The mail server must be 
available full-time because 
Clients & Profits X sends 
mail throughout the day.

Every staffer must have an 
e-mail address  (e.g., john@
agency.com).  For security 
reasons, C&P e-mail is gen-
erally sent only to staff 
members and not to people 
outside 
the shop. This prevents 
confidential 
information from being to 
sent to 
clients, vendors, and possibly 
competitors. However, “cc’s” (i.e., 
carbon copies) and “bcc’s” 
(i.e., blindcarbon copies) have 
no such limitation. This means users 
who manually send e-mail from Clients & Profits X can potentially send it to 
anyone.

■  E-mail that is sent from the Help E-mail window to the C&P Helpdesk is 
considered as confidential and private. However, e-mail send to the C&P User 
Group or the C&P Wish List is considered public and can be read by anyone 
subscribing to those mailing lists.

The Clients & Profits X e-mail system is based on an internal calendar. Stored 
mail is automatically checked each morning when the first user opens the 
database. Any pending mail is then sent. E-mail is automatically sent from 
these areas:

TimeCop  Staff members who haven’t accounted for enough hours (i.e., actual 

The Update User E-Mail Addresses 
window lets you easily update the de-
partment and e-mail address settings 
for all staff members at 
one time.

vs. planned) on the previous day’s time card/time sheet get a user-defined 
reminder via e-mail.
Quick Check  The system manager is notified via e-mail if daily Quick Check 
finds a problem with the database.

Media Calendar  Scheduled entries from the media calendar can remind 
media department staffers of space closing dates, material due dates, dates 
of special promotions, and meeting dates.

Cash Flash  A daily “cash 
flash” of the shop’s current 
cash, A/R, and A/P balances 
can be e-mailed to agency 
management. In addition, 
e-mail “ticklers” can be sched-
uled to remind the accounting 
staff about unpaid invoices, 
tax deposits, appointments, 
and other follow-up.

Client Diary  When a user 
adds a diary entry, a copy can 
be e-mailed to a staff member. 
Entries can be scheduled to be 
sent in the future to automate 
account follow-up.

Job Tickets  E-mail can be au-
tomatically sent to accounting, 
production, or management 
when a new job is opened, its 
status code is changed, or the 

job is closed.  Production people are notified of impending task deadlines 
several days ahead of time via e-mail. When a user adds a job diary entry, a 
copy can be sent to account service, production, or accounting.

To start C&P e-mail:

1  Choose Setup > Preferences > C&P E-mail.

2  Click the Automatically send e-mail checkbox, then click Save.

To stop C&P e-mail:

1  Choose Setup > Preferences > C&P E-mail.

2  Uncheck the Automatically send e-mail checkbox, then click Save.

Need more info about C&P Mail?  Find out how to use more auto-
matic e-mail features from the C&P Mail FAQ (i.e., frequently-asked 
questions) page:  www.cnp-x.com/support/FAQs/FAQ_email.html
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The C&P E-mail Preferences window

1  This option starts up the auto-
matic e-mail system, including the 
daily TimeCop (which sends e-mail 
reminders to staffers who haven’t 
finished their time cards). If this 
option is unchecked, no e-mail 
will be sent from Clients & Profits 
Pro X.

2  Enter the name of your SMTP 
mail server server here. The mail 
server must be accessible on your 
network for the automatic e-mail to 
function. If not, an error will appear 
each time mail is sent.

3  The system manager is auto-
matically notified via e-mail when 
there’s a problem with Clients & 
Profits X . If there are multiple 
system managers, choose the one 
who is most responsible for the 
day-to-day operation of Clients & 

Profits X . This person should also 
be the primary in-house contact for 
C&P questions and troubleshooting; 
all internal help e-mail sent by us-
ers will be delivered to this system 
manager.

4  If the system manager is a staff 
member, his or her e-mail address 
will be copied to the system 
manager 
e-mail address field automatically. 
If the system manager is an outside   
consultant, or has a special e-mail 
address, you’ll need to enter the 
e-mail address here. 

5  Clients & Profits X has a built-in 
help e-mail function that can be 
used by anyone using the system. 
This makes it very easy for users to 
send questions and report problems 

without quitting Clients & Profits 
X. When a user chooses Send Help 
E-mail from the Lookup menu, 
the message is sent to the system 
manager by default (although it 
can be sent instead to the C&P 
Helpdesk, the C&P User Group, 
or the C&P Wish List). The system 
manager can preset a standard 
message that appears every time 
a user sends a help e-mail. It can 
be used to explain how to get help, 
how to explain the user’s problem, 
or some other kind of helpful notes 
for the user.

6  The missing time message is a 
standard e-mail message that users 
see in when they haven’t finished 
their time card. It can be changed 
anytime to keep it fresh—and to 
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keep users from readily ignoring it.

7  The send e-mail about overdue 
tasks option notifies staff members 
every morning about their overdue 
dates (i.e., job tasks that have a 
due date prior to the current day). 
If the production department isn’t 
very timely about marking tasks as 
finished, this option could generate 
dozens of meaningless e-mail. The 
send e-mail about over-budget 
tasks notifies AEs whenever some-
one adds a cost that makes a task 
exceed its budget.
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“We thought we could 
get away with a generic 
accounting package. But 
it just didn’t work. We 

needed something 
designed for the way we 
work. Clients & Profits X 

was the answer.”

www.clientsandprofits.com

CPA Software News just recognized what our users have 

known for years.  There’s no substitute for real ad agency 

management software. One that speaks the language of 

advertising. One that knows how an ad agency works. That’s 

why over 1,600 shops chose Clients & Profits X®. And why 

it’s the best-selling agency system for Mac,Windows, and 

the web. Call today [800] 272-4488.


